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To center a line in MS Word 2007, select the
Home tab. In the Paragraph section, choose the
Center symbol (multiple lines centered in a small
box). To center pre-existing text, highlight the text

first and follow the steps above.

For addition guidance in using MS Word 2007, go to the
Ashford Writing Center. In the Writing Resources section,

look for the Microsoft Word 2007 Basics Tutorial and the
Basic Guide for Using Microsoft Word (2007).

To insert a header in MS Word \
2007:

1. Select the Insert tab. In the
Header and Footer section,
select Header, and a drop
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Choose Blank.

2. This will open the Header
and bring the “Header and
Footer Tools” options to the
top menu bar. Check the box
for Different First Page.
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Head:” is only listed on the
title page.

3. Clicking on Page Number
will present a menu of page
numbers. The page number
should be in the top right
corner of the paper.

4. With the page number
highlighted and the cursor in
front of the number, hit the
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cursor is aligned with the left
margin (the number will also
temporarily be in the left
margin).

5. Then, type “Running head:”
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all caps.

6. After typing the “Running
Head” and title, hit the “tab”
key until the page number is
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7. On page 2 of the paper,
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the right margin). Then,
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Head").
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Internet and Distance Education Delivery Models

Technological developments over the past twenty years have given people across the

globe the ability to interact and obtain information at a tremendous rate. Due to these

developments, the field of distance/edumﬁmjsﬂmmmm_mmﬁwmfﬁ
The entire paper should be double-spaced. Use the automatic

research conducted on the availab

This increased interest has led to

primary methods for course deliv

double-spacing command. Select the Page Layout tab. In the
Paragraph section, click on the small symbol on the lower right
corner of the section (downward-right facing arrow in a tiny box).
This will open the Paragraph dialog box. In the Spacing section
select “double” from the line spacing menu. Click OK.
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three course models: synchronous, asynchronous, or blended.

Synchronous course delivery is conducted in ‘real time.” This means the instructors and

students are online at the same time and typically interact via streaming video, live chat, or in a

net-meeting format. Students can post or ask questions and receive immediate responses from

the course instructor or other students.
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/ Align the text of the essay along the left margin. Select \
the Page Layout tab. In the Paragraph section, click on
the small symbol on the lower right corner of the section
(downward-right facing arrow in a tiny box). This will open
the Paragraph dialog box. In the General section, select ) - )
“Left” from the alignment menu. Click OK. nd to messages in a specific location

on 1s conducted when the students and

es typically occur through a distance-

40nducts online classes using the
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asynchronous method. Students and instructors are assigned to specific online courses. Within

these courses students participate in discussion forums, post assignments, and retrieve learning

materials. Correspondence with the instructor is primarily conducted via the online course

discussion forums and email.

The blended learning model is a combination of both synchronous and asynchronous

delivery. The instructor may have a set lecture time during which all students log into the system

to listen and interact with the class.
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conducted asynchronously by having students post additional discussions and questions to a
specific location within the learning system.

Regardless of the delivery method, all distance-learning systems include course
management. Within the course management system, instructional designers, course authors,
and instructors have the ability to edit content, administer assignments, monitor discussions, and
interact with learners. The course management features of a distance-learning system are one of
the key elements for the successful delivery of a distance education program.

An important factor in selecting a distance-learning system is the ease with which
students and instructors can interact and understand the delivery structure. Students’ success is
often related to their experience with the course technology. If students are to be successful in
learning at a distance, they must be comfortable with the media used to transmit the content of
the course. Ultimately, the distance-learning system should enhance the learner’s experience.

Asynchronous Course Delivery

Within distance education the delivery of information occurs through the use of various
communication methods. When the instructor and learners are separated by time and geographic
location, asynchronous communication occurs. Asynchronous communication does not require
the participants to interact simultaneously. Asynchronous learning tools can be used for a
variety of teaching and workplace situations.

Historically, distance learning involved only the student and instructor. Learners did not
have the opportunity to communicate with one another. Fortunately, technological
advancements have brought much to the field of distance learning. In the teaching arena of
online learning, asynchronous communication can be done by way of e-mail, newsgroups for

discussions, streaming video, and audio. According to Witt & Mossler (2001),
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The new opportunities that a college degree will [provide] is made possible by the

advantages of an online education, including class work on a more flexible schedule, ease
—

of doing research online, ease of collaborating with others at a distance, and access to

This quote is greater than 40 words. eographically far removed from where [one] lives. Online
Therefore, block quotation style

should be used. For blocked quotes,  fible for students to learn from working professionals in their

indent and double-space each line.

red across the country or around the world. (Adult Learning in

the Information Age, para. 1)

Asynchronous communications allow learners to select the time and place for class
participation. Through e-mails and other asynchronous learning tools, students can be a part of a
learning community, set goals, and complete coursework. In the workplace, professionals can
interact without concern for time differences or the high cost of international phone calls. With
the asynchronous model, the user has greater control over the acquisition of information and the
ability to set a convenient time for completing coursework, training, or job-related activities.

Synchronous Course Delivery

Online synchronous course delivery offers students and instructors the most similar
format to a traditional classroom learning experience. While the instructor and students are not
located in the same place, they are interacting and communicating at the same time. Within the
synchronous delivery system, there are many options for the communication and transmission of
course content. In Transforming Learning Methods through Online Teaching the authors address
the role of technology in improving academics, including the benefits of synchronous learning,
particularly for the younger students and their familiarity with “chat room” type technology.
Bach, Haynes & Lewis Smith (2006) state, “Synchronous communication develops its own

curios and quite different type of narrative when compared with face to face discussion, and
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there is often a text based ‘stream of consciousness’” (p. 135). Synchronous delivery of course
instruction also allows for immediate feedback. In the asynchronous delivery model, learners
must often wait for feedback or answers to questions.

An effective synchronous delivery system motivates the learner, provides sufficient time
for learner and facilitator interaction, and operates the course at a steady rate, allowing the
learners time to reflect and ask questions. Like the asynchronous course delivery model, a
successful synchronous delivery system can also provide participants with an effective and
challenging learning experience.

Blended Learning Course Delivery

While asynchronous and synchronous learning systems each offer a specialized approach
to distance learning, a blended learning system can combine the tools of both systems to present
an effective and convenient learning experience. According to Watson (2010), “...blended

learning combines online delivery of educational content with the best features of classroom

interaction and live instruction...” (p. 4) For example, training for supervisors may be divided

-
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year of publication. Direct quotations ~ pcussion board. The next section may be taught in the

\ ontent may be taught via CD-ROM with the learners

should include the page number

(paragraph or heading section for rent blended learning models represent a transfer in

works without page numbers).

way in which online learning demonstrated a change in the

delivery and instructional models for learning at a distance (Watson, 2010).
Course Management Systems
The distance education boom has led many institutions on a search for a management
system capable of delivering courses, sharing information, while managing the varied and often

complex learning tools. As shared by Caplow (2006), the most significant aspects of the course

ASI\{[FSRD Ty August 2010

J 7FOUNDED 1918



ASHF

| TNT

INTERNET AND DISTANCE ED 6

management system include the ability to provide course materials in a web based format, access
to online exams, links to course materials, in addition to a system that supports student and
faculty interaction in discussions and evaluation. Given the increasing number of options
available in distance education, the task of finding a course management system that offers the
necessary options, along with the ability to interact with other technology solutions, can be
daunting. The decision to implement a courseware management system cannot be pieced
together. All distance learning systems, from blended learning systems to content management,
must have the capability and the resources necessary to interact with the course management
system.

Learning technologies have opened the doors to a wide variety of options for distance
education delivery, and each learning model has benefits and limitations (Picciano, 2001). The
internet and learning technologies provide the means for transmitting content, managing courses,
and promoting the interaction of the instructor and learners. When selecting technology for a
distance-learning program, the system that provides the best learning approach should be
utilized. Around the world, students can join the same class, share information, and learn
together. The field of distance education and the various learning systems are continually being
revised and improved. Ideally, the most effective distance learning system is one that provides

students with the resources to be a successful distance learner.

/ Additional APA Format Tips: \

- All terminal punctuation (e.g., period, question mark) is followed by two spaces.
One space is used in reference citations, initials, abbreviations, and with
commas, colons, and semicolons.

- Do not hyphenate words at the end of a line.

- Always have at least two lines of a paragraph at the top or bottom of a page.

o Under the Home tab, in the Paragraph section, click on the small
symbol on the lower right corner of the section (downward-right facing
arrow in a tiny box). This will open the Paragraph dialog box. In the
Paragraph dialog box, click on the Line and Page Breaks tab to ensure
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